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Introducing On This Day for Windows
Have you ever been curious about events that happened on this day in history?    On This Day for 
Windows can generate a list of just such items of note.
Some of the types of information which may be displayed are:

Astronomical Events
Birthdays of Famous People
Historical Events
National Observances
Religious Holidays and Events

In addition, a personal database may be created to contain events important to each specific user.    
Events such as birthdays of relatives and friends may be appropriate for this file.
To clarify, the question this software was written to answer is:

What historical events, religious holidays, etc. happened on a particular date?
It is not intended to answer questions like:

What date is Easter next year?
When was John Wayne born?



Event Types
The currently available event types are:

Birthdays
Events
Religious Events
Personal Events
Monthly Events - these are generated only on the first day of each month



Blanks
This indicates that one or more spaces can be placed here.



Fast Day
A fast day in the Hebrew calendar is one which if it occurs on a Saturday will be moved to the following 
day (i.e., Sunday).



The Software Construction Company
We may be reached via mail at

PO Box 160
North Billerica, MA    01862-0160
USA

We may also be reached via phone (24 hours per day) at
        (508) 851-6204
We may also be reached electronically via one of the following addresses

CompuServe 70313,3615
Internet softcons@world.std.com



The Association of Shareware Professionals
You may contact the Association of Shareware Professionals via mail at

545 Grover Rd
Muskegon, MI    49442-9427
USA

Or via phone at:
(616) 788-5131
(616) 788-2765 FAX



Controlling Output Options
There are several different categories of events that can be selected individually.    Select the  Event 
Types ... command under the Options menu selection.    A dialog box will appear allowing you to choose
which event types should be included in the output of On This Day for Windows.    
Select those event types you would like to have included in On This Day for Windows' output.
The settings you select will be remembered until you change them.



Controlling Output Destination
On This Day for Windows' output can be directed to appear in either a window or a disk file.    The default
destination is a window.
To determine the current setting, select the Options menu.    There will be a check mark next to either 
the Output to File ... command or the Output to Window command.
To change the setting, select the Output to File ... command or the Output to Window command under
the Options menu.    The Output to File ... command will cause a dialog box to appear to specify the 
pathname of the file to which to send the output.



Generating Output at Startup
If you'd like to see the current day's events automatically each time you start On This Day for Windows, 
select the Output Today's Info on Startup choice from the Options menu.    A checkmark will appear 
next to this choice if it has already been selected.    Selecting it again will remove the checkmark (and no
longer cause this option to be in effect).
To have this happen automatically when you start Microsoft Windows perform the following steps 
(depending on your version of windows):
Version 3.0

Add the command WINOTD to the 'load=' line if you'd like On This Day for Windows to be started as 
an icon.    Add it to the 'run=' line otherwise.    Note that you'll have to specify the complete pathname 
(e.g., c:\otd\winotd) unless you installed  On This Day for Windows in a directory specified in your 
PATH environment variable.

Version 3.1
The instructions for Version 3.0 will continue to work for Version 3.1.    However, Microsoft has 
suggested that you use the Startup group for this purpose instead.
Select the WINOTD icon (but don't start the application).    Select Copy... from the File menu and 
select the Startup group in the resulting dialog box.    If you are successful, you should see a new icon
in the Startup group.
To check to see if it will be started as an icon or not, select the WINOTD icon in the Startup group 
(again, don't start the application).    Select Properties... from the File menu.    The resulting dialog 
box will have a checkbox for starting the application as an icon.



Other Configuration Controls
OTDDIR
On This Day for Windows will first search the directory where the executable resides for the databases.   
If they aren't found in that directory, the environment variable OTDDIR will be used to search other 
directories.    The OTDDIR environment variable has the same syntax as the MSDOS PATH variable. 
See your MSDOS manual for more information on how and where to set environment variables.
One way you can use this environment variable is allow you to place all BIRTHDAY databases in one 
subdirectory and all EVENTS databases in another subdirectory specifying all these subdirectories in 
the OTDDIR environment variable.    For example:

SET OTDDIR=C:\OTD\BDAY;C:\OTD\EVT
Or, you might want to place some of the databases on a disk in each of two floppy drives on a system 
without a hard disk.    In this case, you might want to use the following setting to enable On This Day for 
Windows to search two floppy drives for data:

SET OTDDIR=A:\;B:\
Typically, however, this environment variable will be set so that On This Day for Windows command may
be invoked from anywhere on your disk and it will find the appropriate data files in one directory.    For 
example:

SET OTDDIR=C:\OTD
TZ
Some of the events that are automatically calculated (e.g., phases of the moon) display a time 
associated with the event.    If the TZ environment variable is set, the time printed will be your local time.  
If it is not set, the program will assume that it is being run in the Eastern time zone of the United States.
The syntax of the TZ environment variable is:

SET TZ=zzz[+/-]d[d][lll]
zzz is the name of the current time zone (e.g., EST, PST).
[+/-]d[d] is an optionally signed number of one or more digits.    It is the local time zone's difference from 
GMT in hours.    Negative numbers adjust westward from GMT. (e.g., 5=EST, +8=PST, -1=continental 
Europe).
lll is an optional name that represents the local time zone's daylight savings time (e.g., EDT, PDT).    
Don't include this field if your time zone does not observe daylight savings time.



Databases
On This Day for Windows reads event data from a subset of the following databases:

BIRTHDAY.JAN EVENTS.JAN
BIRTHDAY.FEB EVENTS.FEB
BIRTHDAY.MAR EVENTS.MAR
BIRTHDAY.APR EVENTS.APR
BIRTHDAY.MAY EVENTS.MAY
BIRTHDAY.JUN EVENTS.JUN
BIRTHDAY.JUL EVENTS.JUL
BIRTHDAY.AUG EVENTS.AUG
BIRTHDAY.SEP EVENTS.SEP
BIRTHDAY.OCT EVENTS.OCT
BIRTHDAY.NOV EVENTS.NOV
BIRTHDAY.DEC EVENTS.DEC
RELIGION EVENTS.OTH
PERSONAL

If birthday information was requested, BIRTHDAY.<current-month> will be read.    If event information 
was requested, EVENTS.<current-month> and EVENTS.OTH will be read.    If religious information was 
requested, RELIGION will be read.
See Controlling Output Options for more information on requesting different event types.
Entries are displayed in the order in which they appear in the database.    If you want your events to 
occur in a particular order, place them in that order in the database.
On This Day for Windows is distributed with all the above databases with the exception of PERSONAL.   
Note that registered users receive a set of databases with a much larger collection of data.    See 
Registering   On This Day for Windows   for more information on the benefits of registration and how to 
register.
The database named PERSONAL is used to add any personal information you care to track with the 
program but do not wish to get lost in our data.    You are, of course, free to intersperse your data with 
ours.    It is entirely up to you and what you wish to do with the program.
See also Compressing Databases.



Navigating Through the Calendar
If the correct month and year are already displayed, simply select the square representing the day in 
which you are interested (see Selecting the Day to Display for more information).
If the month displayed is not correct or is from the wrong year, there are several ways of changing it to 
the correct month and year ...

To move forward and backward a month at a time:
Use the << and >> buttons.
Use the Page Up and Page Down buttons.
Use the "Previous Month" and "Next Month" choices on the "Go To" menu.

To change the month and year at the same time:
Use the button between the << and >> buttons.
Use the "Month/Year ..." choice on the "Go To" menu.



Selecting the Day to Display
On This Day for Windows displays a conventional "month at a time" calendar.    The currently selected 
day will appear red.    Pressing the enter key will generate output for the currently selected day.
There are a number of ways to select a different day:

Use the "Today" choice on the "Go To" menu to jump immediately to today's date.
Use the left and right arrow keys to move forward and backward a day.
Use the up and down arrow keys to move forward and backward a week.
Click on the date desired.    Note that this will also generate output.    The above methods of 
movement require that you press enter to actually generate output.



Frequently Asked Questions
This section will attempt to answer some of the more frequent questions we've gotten.

How can I print a copy of the output?
How can I create a copy to share with my friends?
How do I register On This Day for Windows?
What are your sources for this information?
How can I add personal data to On This Day?
Why isn't my favorite event or holiday listed?



How Can I print a copy of the output?
The easiest way to print a copy of On This Day for Windows' output is to send the output to a file (see    
Controlling Output Destination) and then print the file.    You can print the file from File Manager, 
Notepad, Write, etc.



What are your sources for this information?
I have used a great many sources to amass this collection of information.    Virtually everything I've read 
since sometime in 1985 has been used as a source from one time or another.    Less frequently, I use 
radio and TV broadcasts as sources.    I find them to be a bit less reliable for dates than printed media.
It is important to state here that we do not guarantee the information's accuracy in any way.    You may 
find duplicate entries or other mistakes.    We do our best to keep the data as "clean" as possible and 
appreciate hearing about any mistakes (or additions) you find.
When writing about mistakes or new entries, please try to give supporting evidence.    We are trying to 
keep track of sources in order to arbitrate any possible discrepancies in the dates.
Lastly, we must point out that we reserve the right to ignore any and all suggestions related to our data.   
As a registered user, you will have access to all the files that we have and may remove events you don't 
like, add ones you think should be added, and improve the wording of others.    We hope you will 
understand.
See Also Bibliography



Creating a Copy to Share with Your Friends
There are two versions of On This Day for Windows in circulation:

The Evaluation Version
The Registered Version

If you've paid the registration fee to The Software Construction Co. (see Registering   On This Day for   
Windows for more information ) you have The Registered Version.    If you have not registered your 
copy and see only a handful of birthdays and events when you request a date, you have The 
Evaluation Version.    If you have not registered and see a large number (i.e., 30 or more events per 
day), you have The Registered Version (which you shouldn't have).
To share a copy with your friends, perform the following steps, depending on which version you have:
The Evaluation Version

Copy the directory containing the executable and data files to a diskette (e.g., COPY c:\
otd\*.* a:).

The Registered Version
Make certain you are in MSDOS (either an MSDOS shell within Microsoft Windows or at 

the MSDOS prompt prior to entering Microsoft Windows.
Change your directory to the directory where On This Day for Windows was installed 

(e.g., cd c:\otd).
Execute the OTDSHARE batchfile specifying the diskette drive containing the diskette 

onto which you'd like the software copied (e.g., otdshare a:).



Adding Personal Data
On This Day for Windows will read a database file with the name PERSONAL as well as the files 
distributed from the manufacturer.    Create this file in the same directory as the other data files.    For 
more information, see databases.



Holiday or Event Missing
If you are a registered user and are using the larger databases sent to registered users, we'd very much 
like to learn of the data that you think we've overlooked.    Obviously, we can't have all holidays and all 
events listed.    We'd like to come as close as possible, however.    See The Software Construction Co. 
for the various methods you can use to contact us.
If you are using the evaluation version, we may be aware of the data you have noticed missing.    We 
deliberately don't distribute out entire collection of data.    We do this for two reasons:

1. The distribution would be much too large and would discourage people from downloading 
the program for a trial.

2. We reserve the larger databases as a reward to those who register our program.
The program in the evaluation version is identical to the registered version.    You are welcome to add 
the data to the evaluation databases if you would like to see it displayed.
For more information on the benefits of registration, see Registering   On This Day for Windows  .



Year
This is a decimal digit indicating the year.    All digits should be indicated (e.g., 1992 should not be 
abbreviated 92).    On This Day for Windows will attempt to extrapolate most years even if the calendar 
currently being used was not yet in existence.



Day
This is a decimal digit indicating the day.    Valid values depend on the calendar currently being used and
the month specified.



Calendars
On This Day for Windows can currently calculate dates in the following calendars.    Use the characters 
following the calendar name to create a relative date specifier.

Gregorian G
Hebrew H or HF to specify a fast day
Islamic I
Julian J



Month
This is a decimal digit indicating the month.    Valid values depend on the calendar currently being used.



Weekday
Valid weekday values are:

Monday M
Tuesday T
Wednesday W
Thursday R
Friday F
Saturday S
Sunday U



Date Specifiers
Date specifiers may have one of the following forms:
Absolute dates

month
If the specified month matches that in the date specifier and the monthly event type has been chosen,
then the item is output.

month/day
If the specified month and specified day matches that in the date specifier, then the item is output.

month/day/year
If the specified month, specified day, and specified year matches that in the date specifer, then the 
item is output.    Note that this is the only one of the three formats that will include a year in the output.

Relative dates
alternate calendar absolute date

This indicates to use the specified calendar to evaluate the absolute date following.    See above for a 
discussion of absolute dates.

absolute date + days
Add the specified number of days to the absolute date.    For example, 1/3+37 in the Gregorian 
calendar is the same as 2/9.    See above for a discussion of absolute dates.

absolute date - days
Subtract the specified number of days from the absolute date.    For example, 1/3-21 in the Gregorian 
calendar is the same as 12/13.    See above for a discussion of absolute dates.

weekday(month/day)
This indicates the first weekday occurring on or before the date specified by month and day.    For 
example, W(8/14) specifies the second Wednesday occurring in the month of August in the Gregorian
calendar.

weekday(*)
This indicates every occurrence of weekday.    For example, M(*) specifies every Monday.

E
This indicates the Christian holiday Easter.

E + days
Add the specified number of days to the date of Easter.

E - days
Subtract the specified number of days from the date of Easter.

*
This indicates every day.

* + days
This indicates to add the specified number of days to the current date requested.    This is useful in 
the command line version of the product in order to be able to ask for tomorrow's data.

* - days
This indicates to subtract the specified number of days to the current date requested.    This is useful 
in the command line version of the product in order to be able to ask for yesterday's data.



Database Format
A line in a database may be in one of the following forms:
#:stuff

This line is ignored.    It is useful to add commentary to a file.
date specifier:stuff

Should the date requested match the relative date, stuff will get output.
blanks:stuff

This format indicates a continuation of the preceding line.



Compressing Databases
On This Day for Windows can read either normal text databases or those that have been compressed 
with the included compression program (CMP).  On This Day for Windows determines automatically 
whether a database is compressed or not and uses the appropriate method to read it.
You may replace any or all uncompressed databases with compressed ones and vice versa.    The 
compressed databases are smaller but take longer to read.    Therefore, if you value disk space more 
than execution speed, you should try to compress as many databases as possible.    If you value 
execution speed more than disk space, uncompress as many databases as possible.



Registering On This Day for Windows
Registering On This Day for Windows costs just $30.00 (US funds).    Massachusetts residents must 
include 5% sales tax.

Registered users of On This Day for Windows receive the following benefits:
Notification of any updates
The latest version of the software
A much more extensive collection of data
Several other utilities which make the maintenance of the databases easier
A collection of quotations and a program to display them

Although we encourage copying and sharing of On This Day for Windows, we must insist that registered 
users NOT share the larger databases, the quotation database and program, and any utilities not 
included in the evaluation version.    We retain full copyrights to these files.    It is an infringement of 
copyright law to distribute copies of these files.
In order to make this easier, registered copies of On This Day for Windows contain a batch file which will
create an evaluation diskette that you may freely share.    See the README.TXT file on your registered 
diskette for more details.
You can, of course, register On This Day for Windows directly from The Software Construction Company
(click on our name for how to contact us).    We accept cash, checks, money orders, and purchase 
orders.    Please specify 5¼ or 3½ diskettes (If you don't specify, we'll ship 3½ diskettes).    We have 
made this as easy as possible by providing a "Register" command under the Help menu.
We have arrangements with two companies to take credit card orders on our behalf:
Public (software) Library
PO Box 35705
Houston, TX      77235-5705
(800) 242-4775 Orders
(713) 524-6398 FAX
(713) 524-6394 Information and Help
CompuServe: 71355,470
will accept Mastercard, Visa, American Express, and Discover payments
BUDGETWARE
PO Box 496
Newtown NSW 2042
AUSTRALIA
(02) 519-4233
(02) 516-4236 FAX
will accept Bankcard, Mastercard, and Visacard.    Payment is $49 (Australian funds).
You can also register using CompuServe's® registration service (GO SWREG at any prompt).    Our 
product numbers are as follows:

Diamond Data #2063
On This Day for MSDOS #2074
On This Day for Windows #2093

See also Evaluation diskettes.



Evaluation Diskettes
For $5 (US funds) to cover our costs (refunded when you register), we will supply you with the latest 
edition of the software.    Please specify 5¼ or 3½ diskettes (If you don't specify, we'll ship 3½ diskettes).



Bug Reports
Should you discover a bug in this code, please let The Software Construction Company (click on our 
name for ways to contact us) know.    Please provide us with as much of a description of the problem as 
you can, as well as your name and address.    If you would prefer being contacted by phone, add your 
phone number and the hours we can reach you.



Known Problems/Limitations
The Jewish holiday Ta'anit Esther occurs on the preceding Thursday when Purim falls on Sunday.    
There is no currently known way to indicate this relationship.
There is a similar problem with the Fast of the Firstborn when Passover occurs on a Sunday.



Bibliography
Special thanks to John Peyton, a friend who helped get me thinking along the right path several times.
Following is a list (no doubt partial) of items I found helpful when learning how to calculate the various 
calendars, astronomical events, etc. that are contained in On This Day for Windows:

Astronomical Formulae for Calculators by Jean Meeus, 1982, Willmann-Bell, Inc.
Calendrical Calculations by Edward M. Reingold and Nachum Dershowitz, 1989, University of Illinois 
at Urbana-Champaign.
Practical Astronomy With Your Calculator by Peter Duffett-Smith, 3rd edition 1988, Cambridge 
University Press.

Many people have asked for a list of the sources for the events contained in the databases.    I have 
used a huge number of them and it would be impossible to list them all.    However, some of the most 
helpful are:

Book of Holidays Around the World, The by Alice van Straalen, E.P. Dutton.
Chase's Annual Events, Contemporary Books, Inc.
Encyclopedia of American Facts and Dates, The, Harper and Row.
Glory and the Dream, The by William Manchester, Bantam Books.
Old Farmer's Almanac, The, Yankee Publishing Inc.
People's Chronology, The by James Trager, Henry Holt and Company.

This list does not include the several almanacs, numerous newspapers and magazines that have 
contributed to the collection of data since 1985.



Gregorian Calendar
This is the calendar currently used by much of the world (including the United States).    It was designed 
by a commission assembled by Pope Gregory XIII in the sixteenth century.    It is based on the revolution
of the earth about the sun.
The months and their corresponding numbers that are legal for this calendar are:

Name Num Num Days
January 1 31
February 2 28 (29 on leap years)
March 3 31
April 4 30
May 5 31
June 6 30
July7 31
August 8 31
September 9 30
October 10 31
November 11 30
December 12 31



Hebrew Calendar
This calendar was placed in operation in the mid-fourth century by Hillel II.    It is based on the moon's 
revolution about the earth.    However, it has solar corrections built in.    These corrections take the form 
of leap months that are periodically added to the calendar.
The months and their corresponding numbers that are legal for this calendar are:

Name Num Num Days
Nisan 1 30
Iyyar 2 29
Sivan 3 30
Tammuz 4 29
Av 5 30
Elul 6 29
Tishri 7 30
Heshvan 8 29 or 30
Kislev 9 29 or 30
Teveth 10 29
Shevat 11 30
Adar 12 29 or 30
Adar II 13 29

Note that Adar II is a leap month.    When there is an Adar II, Adar is named Adar I.
Certain holidays (fast days) must be moved to the following day (Sunday) if they fall on a Saturday.    
See calendar specifiers for a way to specify this in the databases.



Islamic Calendar
This calendar is based upon the moon revolving around the earth.    There are no dates in this calendar 
before Friday, July 16, 622 (Julian).
Much of the world does not agree with the calculations to determine this calendar.    They rely on the 
proclamation of the new moon by the authorities at al-Azhar in Cairo to define the calendar.    
Consequently, the dates computed in On This Day for Windows may differ by a day from those observed
by much of the Islamic population of the world.
The months and their corresponding numbers that are legal in this calendar are:

Name Num Num Days
Muharram 1 30
Safar 2 29
Rabi I 3 30
Rabi II 4 29
Jumada I 5 30
Jumada II 6 29
Rajab 7 30
Sha'ban 8 29
Ramadan 9 30
Shawwal 10 29
Dhu al-Qada 11 30
Dhu al-Hijjah 12 29 or 30



Julian Calendar
This calendar was instituted in 45 BC by Julius Caesar.    It is based on the revolution of the earth about 
the sun.
The months for the Julian calendar are the same as those for the Gregorian calendar.



User Supported Software
This program is produced by a member of the Association of Shareware Professionals (ASP).    The ASP
wants to make sure that the shareware principle works for you.    If you are unable to resolve a 
shareware-related problem with an ASP member by contacting the member directly, the ASP may be 
able to help.    The ASP Ombudsman can help you resolve a dispute or problem with an ASP member, 
but does not provide technical support for members' products.    Please write to

ASP Ombudsman
545 Grover Rd
Muskegon, MI      49442

or send a CompuServe message via CompuServe mail to the ASP Ombudsman at
70007,3536

See also Definition of Shareware, Disclaimer - Agreement.



Definition of Shareware
Shareware distribution gives users a chance to try software before buying it.    If you try a shareware 
program and continue using it, you are expected to register.    Individual programs differ on details ... 
some request registration while others require it, some specify a maximum trial period.    With 
registration, you get anything from the simple right to continue using the software to an updated program
with printed manual.
Copyright laws apply to both shareware and retail software, and the copyright holder retains all rights, 
with    a few specific exceptions as stated below.    Shareware authors are accomplished programmers, 
just like authors of retail software, and the programs are of comparable quality.    (In both cases there are
good programs and bad ones!)    The main difference is in the method of distribution.    The author 
specifically grants the right to copy and distribute the software, either to all and sundry or to a specific 
group.    For example, some authors require written permission before a commercial disk vendor may 
copy their shareware.
Shareware is a distribution method, not a type of software.    You should find software that suits your 
needs and pocketbook, whether it's retail or shareware.    The shareware system makes fitting your 
needs easier, because you can try before you buy.    And because the overhead is low, prices are low 
also.    Shareware has the ultimate money-back guarantee ... if you don't use the product, you don't pay 
for it.
See also Disclaimer - Agreement, User Supported Software.



Disclaimer - Agreement
Users of this program must accept this disclaimer of warranty:

On This Day for Windows is supplied as is.    The author disclaims all warranties, expressed or 
implied, including, without limitation, the warranties of merchantability and of fitness for any 
purpose.    The author assumes no liability for damages, direct or consequential, which may 
result from the use of On This Day for Windows.

This program is distributed as shareware and is provided at no charge to the user for evaluation.    Feel 
free to share unaltered copies of it with your friends.    The essence of "user-supported" software is to 
provide personal computer users with quality software without high prices, and yet to provide incentive 
for programmers to continue to develop new products.    If you find this program useful and find that you 
are using it and continue to use it after a reasonable trial period, you must make a registration payment 
of $30.00 (US funds) to The Software Construction Company.    Massachusetts residents must include 
5% for sales tax.    This registration fee will license one copy for use on any one computer at any one 
time.    You must treat this software just like a book.    An example is that this software be used by any 
number of people and may be freely moved from one computer location to another, so long as there is 
no possibility of it being used at one location while it's being used at another, just as a book cannot be 
read by two different persons at the same time.
Commercial uses of this program must register and pay for their copies within 30 days of first use or 
their license is withdrawn.    Site-License arrangements may be made by contacting The Software 
Construction Company.
Anyone distributing this program for any kind of remuneration must first contact The Software 
Construction Company for authorization.    This authorization will be automatically granted to distributors 
recognized by the Association of Shareware Professionals as adhering to its guidelines for shareware 
distributors, and such distributors may begin offering this program immediately (however, The Software 
Construction Company must still be advised so that the distributor can be kept up-to-date with the latest 
version).
You are encouraged to pass a copy of this program along to your friends for evaluation.    Please 
encourage them to register their copy if they find that they can use it.    All registered users will receive a 
copy of the latest version of the program.
If you have received this software through one of the so called "Shareware Houses" (companies whose 
business is selling diskettes containing other authors' software), please note that none of the money you
have paid so far has (or will) make its way to the author.    You have simply paid for the duplication and 
distribution costs.
See also Definition of Shareware, User Supported Software.


